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Abstract - The presence of tiny dust particles, soil, or soot 
over the solar panels decreases the efficiency of the solar 
plates, which causes overburden on the power grids, due to the 
overburden there can be severe blackouts, therefore online 
surveillance of the power grids become cardinal for the fault 
detection and maintenance of the power grids [1]. This paper 
presents “A Robust IoT-Based Smart Energy Grid Monitoring 
System with Robotic Maintenance” to address the constraints 
in the cloud computing [2] paradigm in power networks—
where many issues remain unresolved, such as completely 
achieving the requirements for significant bandwidth with low 
latency—this study presents an edge computing [3] system for 
IoT (Internet of Things) [4] based smart grids. The novel 
solution develops an innovative software and hardware design 
and primarily integrates edge computing into conventional 
cloud-based power networks. As a result, an enormous amount 
of data produced by the power grids will be examined, 
handled, and kept at the network’s edge. The edge computing 
paradigm will let IoT-based smart grids connect and manage 
large terminals, process and analyze vast amounts of data in 
real time and encourage the digitalization of smart grids. 
Furthermore, the IoT-based smart girds, provide privacy 
protection techniques based on edge computing, data 
forecasting, and pre-processing schemes of hierarchical 
decision-making based on task grading (HDTG) [5]. An inbuilt 
robotic water motor in the suggested model cleans the 
photovoltaic panels. The numerical simulations provide 
validation of the proposed model's efficacy. 
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1. INTRODUCTION 
 
Today we are facing a huge power problem. With the 
increase in gadgets, our requirements have increased. Solar 
energy is the most advanced sustainable power source in 
this system. Solar energy production is now the most 
practical and economical form of green energy [6]. We are 
trying to implement this concept in many sectors starting 
from small to large sectors like urban areas, Industries, and 
Individual houses. Researchers are going to convert 
transports to use this technology to reduce the world’s major 
problems like pollution. Electric Vehicles have started 
entering in the market which will again put the loads on the 
electric power plants [7]. 

 
So to reduce the overburdening on power grids, the solar 
power plants and small solar units can helps in reducing the 
burden and also helps to get more clean energy. Concerning 
solar power systems, it is crucial to keep an eye on the 
power output of the photovoltaic panels in order to achieve 
maximum efficiency. That is the reason it is essential to 
implement a real-time surveillance system [8]. It may also be 
utilized for the surveillance of the power produced from 
individual panels in a big solar power plant, which assists in 
locating any dust accumulation. Additionally, it eliminates 
any fault situations from arising while the system is in use. 
When it comes to small solar units like the solar in 
communities, villages, and cell phone towers where these 
units are managed and maintained by individuals [9]. If the 
maintenance is not done regularly then the efficiency of 
panels goes down and there may be high power loss. 
 
So to overcome these problems we have come up with the 
proposed novel model by which the whole thing can be 
monitored, get alerts on phone or mail, and even automated 
according to the customer calendar and needs of the system. 
  

1.1 Benefits of Solar Energy 
 

Do exorbitant electricity costs and unstable power 
supplies restrict your ability to use electricity as freely as you 
would like? Imagine being able to turn on your TV, air 
conditioning, heater, refrigerator, computer, food processor, 
and other appliances without any outages thanks to the sun’s 
energy, all while offering you an incredible chance to reduce 
your monthly electricity bills. Solar energy investment is the 
way of the future! It minimizes your carbon impacts, your 
reliance on centralized power sources, and much more in 
addition to helping you save money on electricity bills [9]. 
Let’s examine the main advantages of switching to solar 
electricity for residential use. 

(I) Save lots of money  

The ability to save money on monthly electricity expenses 
is the main benefit of using solar energy for residential 
purposes. Deploying rooftop solar panels can save up to 95% 
of your monthly electricity bills, according to a combined 
study by the power distribution company BSES Yamuna 
Power Limited (BYPL) and the legislative & research body 
Council on Energy, Environment and Water (CEEW) [10].  
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(II)  Increase the property value  

It may surprise you to learn that adopting solar panels can 
raise the value of your house by 3–4%. Installing a rooftop 
solar power system increases the value of your house and 
gives real estate professionals a compelling reason to 
promote it. According to US research, owners who sell their 
homes with solar power systems not only recover the initial 
expenditure of the installation but also gain a bonus that 
boosts their return on investment [11]. 

(III) Freedom from centralized grids  

You immediately become less reliant on centralized private 
or governmental grids once you switch to solar power. In an 
environment where demand is rising and supply is erratic, 
being independent is ultimately the most prudent and 
sustainable course of action. A safe investment for the future 
is solar energy. Your solar energy system will become even 
more independent if you include a backup battery. Under 
such circumstances, you would be producing and storing 
your own electricity in case the main grid failed. In this way, 
anyone can achieve complete energy independence [12].  

(IV) Contributing to a better environment 

Electricity produced from fossil fuels may be handy, but the 
ecosystem suffers greatly from it. Installing solar energy 
systems contributes to an environmentally conscious 
investment in a clean, renewable energy source. Solar energy 
is entirely clean; it doesn’t cause any greenhouse gas 
emissions or contamination of the air or water. Additionally, 
it emits no hazardous pollutants; solar panels do not release 
any carbon during the production of power. Further, it 
minimizes carbon footprints and the need for limited 
resources. 

The United States is the largest user of renewable energy, 
although making up a small portion of all energy utilized. 
However, even with ten years of increased solar energy 
availability, solar energy still only contributes up to 2.3% of 
the entire energy consumed in the United States. With 11.5% 
of the clean energy consumed in the United States in 2019 
coming from solar power, hydropower and wind are still the 
most prevalent sources of clean energy [13]. 

1.2 Challenges with IoT based Smart Grids  
 
At present, there are only two kinds of solar technology 
available, photovoltaic and solar thermal that can harness 
the energy of the sun to generate electricity. Solar thermal 
collectors use energy from the sun to warm houses or water. 
Solar energy is used by photovoltaic devices to add to or 
substitute electricity from the power grids. 
 
(1)  Upcoming study initiatives must address numerous 
problems in order to meet technological goals for IoT 
applications in smart grids. IoT devices need to meet specific 

standards, like compatibility and credibility, to function in 
many locations that may include extreme conditions (such as 
worst weather, high voltages, exposure to electromagnetic 
waves, functioning in water, etc.) [14].  
 

(2) It is important to employ or build appropriate energy 
harvesting strategies since many Internet of Things (IoT) 
gadgets and sensors run on batteries (such as different kinds 
of sensors used for the surveillance of transmission lines). 
IoT devices should implement the essential communication 
protocols because SG has many communication networks 
spread throughout different areas. This will ensure an 
adequate and reliable flow of data from smart meters to the 
central system. 
 

Data fusion procedures should be implemented to compress 
and aggregate relevant data in order to have improved 
energy and bandwidth utilization as well as collecting data, 
since IoT gadgets in SG have finite resources and capabilities, 
like batteries, processing power, storage, or bandwidth [14]. 
 
(3) Two crucial factors that impact how well a smart grid 
performs are delay and packet loss. Congestion reduces 
system performance because it results in packet loss and 
delay. Furthermore, because IoT gadgets or gateways have to 
send back data, it increases the likelihood of future 
congestion and produces additional delay. Moreover, SG is 
unable to meet predefined demands, such as the maximum 
tolerated latency. As a result, it’s essential to reduce latency, 
optimize network architecture by figuring out the ideal 
quantity of gateways and Internet of Things gadgets, and 
reduce the number of links to each gateway. The 
interoperability of these devices is essential for data 
exchange because the smart grid is made up of a wide 
variety of gateways and IoT gadgets with varying resources 
and requirements. With IP-based systems, interoperability 
can be achieved in part. IoT gadgets supporting various 
communication protocols and topologies are another way to 
solve this issue [15]. 
 

(4) Big data, which can use an excessive amount of electricity 
along with additional resources and cause congestion, is 
produced by sensors, smart meters, and other devices that 
monitor and gather information within the smart power 
grid. The smart power grid should be built in a way that 
allows for the effective processing and storing of the massive 
volume of data that has been gathered [16]. 
 

(5) There are numerous independent IoT device standards, 
but the smart power grid does not have a single, cohesive 
standard for IoT devices. IoT gadgets within smart power 
grids may experience problems with security, dependability, 
and compatibility as a result. Thus, it is important to 
coordinate standardization activities in smart power grids. 
 
We utilize the Internet, which is vulnerable to cyber-attacks, 
to track and operate IoT gadgets in the smart grid. Hackers 
can alter measured data [17] by sensor and smart meter 
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which can result in major monetary losses. Therefore, by 
taking into account the resource constraints of IoT gadgets 
and coming up with appropriate security solutions for these 
gadgets, we should establish safe communications for IoT 
gadgets in the SG. IoT gadgets, for instance, are limited in 
terms of computing and storage. As a result, we need to 
come up with or employ safety measures that are compatible 
with IoT devices. Certain details regarding the habits of 
customers (such as wake-up hours) may be gleaned from the 
statistics that smart meters measure, hence it is essential to 
ensure that consumers’ consent is obtained before using this 
sensitive information. Additionally, appropriate methods for 
safety precautions such as data security, privacy, 
authentication, authorization, management of trust 
(between IoT gadgets owned by various individuals, such as 
consumers and utilities), and identity counterfeiting 
detection must be developed [18]. 

 
1.3 Contributions 
 
The essential feature of this novel work is to provide the 
cheapest and most secure smart grid online monitoring 
system with an additional privacy protection technique by 
utilizing edge computing, data forecasting technique, and pre-
processing technique of HDTG for the IoT-based smart power 
grids. Also, the suggested model has an inbuilt robotic water 
motor to clean the solar plates which will help in reducing the 
men’s labor costs. The numerical simulations provide 
evidence of the efficacy of the suggested methodology. 

The rest of the part of this search study is designed as, In 
Section 2, problem formulation; in Section 3, proposed 
architecture; Section 4, materials and methodology of 
proposed technique; Section 5, hardware prototype and 
results; Section 6 challenges and future scopes and thereafter 
in Section 7, concludes the analysis. 

2. PROBLEM FORMULATION 

When solar plants on a small scale or large scale are set up in 
various parts of India maintenance is required to get the 
maximum power from the system. Due to different pollution 
rates at different times, the dust affects these plates 
differently [19]. So we need to find a solution that can 
monitor the output and let us know when is the best time to 
clean the plates. Cleaning of the panels at the correct time is 
also required as during the daytime the solar panel may be 
hot and may get damaged too. This is our first problem. 

Coming to the wear and tear of the solar plates or wiring in 
these places also reduces the output of the systems so there 
may be confusion when the output goes low it may be 
because of sand particles on the solar plate too. This type of 
error can be corrected by replacing the solar panels or 
rectifying the error in the electrical as per the fault. These 
faults should be cleared as soon as possible as they may 
damage other things also. 

Monitoring the whole output over a long period to find the 
real power generated we need to have some real-time 
record. So this can be either done by keeping a record daily 
of what is the production each day or by a meter. But if we 
get any Mathematical digital tool like a graph so it will be 
easy to understand and can be predicted for more future 
investment in a profitable way.  

Overall the above problem can be solved by the latest 
technology called the Internet of Things [20]. 

3. PROPOSED ARCHITECTURE 

This paper propose an architecture, as illustrated in Fig.1, for 
the online surveillance of electric parameters with robotic 
maintenance of the power grids. It can monitor the current, 
voltage, and power. Since we are using IoT-based 
microcontrollers so can monitor these parameters from 
anywhere in the world via using Internet and daily records 
of electricity production can be saved by using web servers. 
The auto cleaning of the solar panels can be done by utilizing 

Cayenne IoT-based programming [21], we can set the slot to 
clean the panels two times in a week or only on weekends as 
per the convenience of the customers. This proposed 
architecture provides safety, security, and cost reduction in 
electricity to the users. 

 

Fig -1: A Robust IoT Based Smart Energy Grid Monitoring 
System with Robotic Maintenance 
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It is presumed that there is dust or soot accumulated on the 
solar plates which reduces the efficiency of the solar plates 
[22] or there can be an electrical fault in the system which 
may damage the other equipment, and also as we know 
nowadays most of the things are working based on IoT so 
there is a chance of cyber-attack, cyber attackers may steal 
the data of customers, therefore, for the safety and security 
of the customers the proposed model can be implemented 
which deals with all the above-mentioned challenges as well 
as helps in the detection of faults, improving power grids 
efficiency, cheapest online surveillance and robotic 
maintenance. 
 

4. MATERIALS AND METHODOLOGY OF THE 
PROPOSED MODEL  
 

Now we are clear that we have to find a few things for our 
project that can cover all three of the problems as mentioned 
in section 2. We need to customize the whole project. So that 
the project will be simple and parts are also easily available 
for the project testing. Therefore we decided to go with the 
following tools and parts. 
 

a) ESP 8266 NODE MCU 
b) Arduino software for programming  
c) Cayenne IoT platform 
d) Mini solar panel 
e) DC water pump for testing  
f) LED’s 
g) Resistor 
h) Battery 
i) Wires 
j) Switches 
k) Pipes 
l) Containers 
m) Basic Electronics stuffs (glue gun, cutter, 

soldering Iron) 
 

 
 

Fig -2: Block Diagram for the Proposed Model 

Fig.2, represents the block diagram for the proposed model. 
The solar panel produces electrical energy by converting the 
sunlight into electrical power thereafter the electrical power 
is stored in the battery. The ESP 8266 MCU microcontroller 
[23] is used to control all system activities like solar panel 
current and voltage sensing, operating water motor, wireless 
fidelity (Wi-Fi) module, ULN 2003 [24], and display.  
 

4.1 Introduction of IoT Platform 
 
In the first stage create an account on the Cayenne website. 
Cayenne, the First Drag-and-Drop IoT Project Builder in the 
World, is released by “MyDevices” [21]. In this project, the 
Cayenne cloud is used. “MyDevices” introduces a free mobile 
app and web portal that enables users to construct IoT 
applications in just a couple of hours rather than months. A 
strong IoT platform called “MyDevices” was created to help 
corporations connect devices quickly, display information, 
apply intricate regulations, and communicate with their 
linked clients. The key features of Cayenne programming are 
mentioned below: 

 A smartphone application that enables remote 
setup, monitoring, and control of sensors & gadgets. 

 Pi may be easily set up within minutes and 
connected to the web, sensors, actuators, and 
accessories. 

 Rules engine that initiates activities across multiple 
gadgets. 

 Dashboard that can be customized using drag & 
drop components for displaying. 

 Scheduling of lights, motors, and actuators. 
 General-purpose input-output (GPIO) management 

can be adjusted by a dashboard or smartphone 
application. 

 Instantaneous desktop or smartphone access from 
anywhere. 

After signing in the Cayenne account. We have selected the 
ESP8266 board. For each device to connect with the cloud it 
requires a unique code. 
 

 

Fig -3: MQQT Credentials for the ESP8266 Node MCU 1 
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Fig -4: MQQT Credentials for the ESP8266 Node MCU 2 
(Solar Pump) 

Fig.3 and Fig.4, show the message queuing telemetry 
transport (MQTT) Username, password, and Client ID. These 
are needed to be placed in the Arduino code and then 
uploaded to Node MCU. When the Node MCU is connected to 
the internet the device is recognized. Since here we are using 
two Node MCU therefore it is needed to set the 2 MQTT 
credentials. 
 

4.2 Circuit Design for The Proposed Model  
 
The circuit is designed by utilizing the “Fritzing” software 
[25] as presented in Fig.5 and Fig.6.  
 
With the ULN2003, Node MCU is selected as high voltage, 
high-current Darlington arrays. These arrays generally have 
7 common emitters and open collector Darlington pairs. 
Capable of withstanding peak currents up to 600 mA, every 
channel has a 500 mA rating. To make the board layout 
simpler, the inputs are pinned adjacent to the outputs, and 
suppression diodes are incorporated enabling inductive load 
control. Which will drive the DC water pump as Node MCU 
cannot drive the motor. Set up the whole diagram according 
to the circuit as shown in Fig.6. 
 
This is the main board that will be controlling the functions 
of cleaning the solar plate from time to time to give us better 
performance. Here we will program in the Cayenne IoT 
platform like event management and hence automation can 
also be done as per the requirement of the user. We can find 
the performance over a certain period by observing the 
graph of the recorded time. 

 
 

Fig -5: Circuit Design for the Solar Panel 1 IoT Setup. 
 

 
 

Fig -6: Circuit diagram for the Second Board with motor 
connection 

4.3 Software required for programming the 
Board 

The Cayenne Node MCU library contains sketch files for 
microcontrollers which send data to and from the Node MCU 
hardware and Cayenne cloud for implementing incoming 
and outgoing commands, actions, triggers, and alerts. The 
Cayenne bring your own technology-application 
programming interface (BYOT-API) [26] is used to connect 
your custom board with the Cayenne Cloud. After writing 
code to connect your board, you can transfer data from your 
system to the Cayenne dashboard & monitor it using 
widgets. You may receive instructions from Cayenne, 
allowing access from anywhere and automation of your 
system. The BYOT-API currently supports MQTT in a variety 
of languages. 
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Here we have used the library and then added the Wi-Fi and 
password. The formula to calculate the voltage generated 
and current in the solar panel circuit. CH340/CH341 driver 
needs to be installed. 
 
Link for the download: 
httloads/CH341SER_EXE.htmlp://www.wch.cn/down 
 

4.4 Environment Setup 

Search and install the Arduino IDE and then install the board 
package or ESP8266 by using the following steps. 
 
(a) In the File -> Preferences add 
http://arduino.esp8266.com/stable/package_esp8266co
m_index.json to the Additional Boards Manager URLs field. 

(b) Load ESP8266 platform from Tools -> Boards Manager. 
For ESP32, manually install the board package by the 
following the instructions here:  
https://github.com/espressif/arduinoesp32/blob/master

/README.md#installation-instructions. 

A. Download this library as a zip file. 
B. Load the downloaded zip library from Sketch. -> 

Include Library -> Add .ZIP Library. 
C. Use a USB to console connector to link the PC and 

ESP module. 
D. Under the tool menu, choose the port and ESP 

module. 
 

4.5 Building Examples 

A. Click the provided example sketch from the 
selected File-> Examples -> Cayenne-MQTT-ESP. 

B. Add your network details and the Cayenne 
authorization password you were given when you 
added your device to the provided sketch. 

C. Put the sketch together and load it into your system. 
Bootload mode may need to be enabled in the 
system in order to load. The Adafruit HUZZAH 
ESP8266 module can be configured using the 
subsequent instructions: 
 
(a) Press down the GPIO0 key.  
(b) Press the Reset icon.   
(c) Put the GPIO0 button up.  
(d) When the device is prepared for uploading, the 

red LED appears to turn on.  
(e) Load your sketch. 

D. Ensure that sample data from your device is being 
sent to the Cayenne dashboard. 

 

 

4.6 Programming Node MCU ESP8266 with 
Arduino IDE 

The Arduino IDE [27] makes it simple to program the Node 
MCU Development Board because of its user-friendly 
interface. Using the Arduino IDE to program a Node MCU will 
only take five to ten minutes. It requires the Node MCU 
board itself, the Arduino IDE, and a USB port. 

Table -1: Node MCU Development Board Pin-out 
Configuration 

 

Pin 
Category 

Name Description 

Power Micro-USB, 
3.3V, GND, 

Vin 

Micro-USB: Node MCU can be 
powered through the USB port 

3.3V: Regulated 3.3V can be 
supplied to this pin to power the 
board 

GND: Ground pins 

Vin: External Power Supply 

Control 
Pins 

EN, RST The pin and the button resets the 
microcontroller 

Analog 
Pin 

A0 Used to measure analog voltage 
in the range of 0-3.3V 

GPIO 
Pins 

GPIO1 to 
GPIO16 

Node MCU has 16 general 
purpose input-output pins on its 
board 

SPI Pins SD1, CMD, 
SD0, CLK 

Node MCU has four pins available 
for SPI communication. 

UART 
Pins 

TXD0, 
RXD0, 

TXD2, RXD2 

Node MCU has two UART 
interfaces, UART0 (RXD0 & 
TXD0) and UART1 (RXD1 & 
TXD1). UART1 is used to upload 
the firmware/program. 

I2C Pins It should be 
found by 

user 

Node MCU has I2C functionality 
support but due to the internal 
functionality of these pins, you 
have to find which pin is I2C. 

 
Use the USB cord to link the board to the PC after installing 
the Arduino IDE on it. Launch the Arduino IDE now, select 
Tools → Boards → Node MCU 1.0 (ESP-12E Module) as the 
proper board, and Tools > Port as the ideal port. To initiate 
the Node MCU board and cause the integrated LED to flash, 
go to Files > Examples > Basics > Flash and load the example 
program. Click on the “upload” button located in the top bar 
once the sample program has been loaded into your IDE. The 
board’s integrated LED begins to blink after the upload is 
complete. The Configuration of the Node MCU Prototype PCB 
Pin-outs is represented in Table 1. 

https://github.com/espressif/arduinoesp32/blob/master/README.md#installation-instructions
https://github.com/espressif/arduinoesp32/blob/master/README.md#installation-instructions
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5. HARDWARE PROTOTYPE AND RESULTS 

The hardware design of a “Robust IoT Based Smart Energy 
Grid Monitoring System with Robotic Maintenance” is shown 
in Fig - 7. 

 

Fig -7: Robust IoT-Based Smart Energy Grid Monitoring 
System with Robotic Maintenance. 

5.1. Monitoring the Power and Voltage Generated 

When the proposed model is activated it shows the output of 
each of the solar panels in the Cayenne software. As 
represented in Fig – 8 (a) and Fig – 8(b). 

 

Fig -8(a): Power and Voltage Generated by Solar Panel 1. 

 

Fig -8(b): Power and Voltage Generated by Solar Panel 2. 

Graphs of the power and voltage generated observation over 
a period of time in each solar plate is shown in Fig – 9 (a) and 
F – 9 (b). 

 

Fig -9 (a): Power Generated by the Solar Plates with Date 
and Time for the Record. 

 

Fig -9 (b): Voltage Generated by the Solar Plates with 
Date and Time for the Record. 

Actions should be taken based on obtained records. By 
observing the graph of the power generated it can be 
understood now the time is to clean the solar plates. So we 
can now turn on the water pump for the cleaning of solar 
plates by manually clicking on the pump icon as shown in 
Fig– 10 (a) and Fig– 10 (b).  

 

 Fig -10 (a): Power and Voltage When Water Pump is off. 
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Fig -10 (b): Power and Voltage When Water Pump is ON. 

5.2. Event Setup for Water Pump: 

 

Fig -11 (a): Event Setup To Turn ON The Water Pump. 

 

Fig -11 (b): Event Setup To Turn OFF The Water Pump. 

If we want to make the water pump run in an event way like 
weekly twice or thrice and at a certain time for a certain 
minute then we can do it. As the season changes the dusting 
speed on the solar plate changes. Fig - 11 (a) and Fig - 11 (b) 
present how to setup the event to turn on/off the water 
pump. 
 
To turn off the motor we can create another event else the 
motor will not off. So let’s assume the solar plates will be 
washed in just 5 minutes and create another event to turn off 
the water pump. So this will clean the solar plates once in a 
week. This system will be turned ON at 5:35 PM and turned 
OFF at 5:40 PM on every Tuesday. 
 

6. Future Research Directions 

Many issues need to be addressed in the coming years in 
order to accomplish technological objectives applying IoT in 
SG: 
 
(1) Big data, which can use an excessive amount of electricity 
along with additional resources and cause congestion, is 
produced by sensors, smart meters, and other devices that 
monitor and gather information within the smart power 
grid. The smart power grid should be built in a way that 
allows for the effective processing and storing of the massive 
volume of data that has been gathered. 
 
(2) There are numerous independent IoT device standards, 
but the smart power grid does not have a single, cohesive 
standard for IoT devices. IoT gadgets within smart power 
grids may experience problems with security, dependability, 
and compatibility as a result. Thus, it is important to 
coordinate standardization activities in smart power grids. 
 
(3) There is a need to come up with appropriate security 
solutions for these IoT-based smart grid gadgets, we should 
establish safe communications for IoT gadgets in the SG. IoT 
gadgets, for instance, are limited in terms of computing and 
storage. As a result, we need to come up with or employ 
safety measures that are compatible with IoT devices. 
 

7. CONCLUSIONS 
 
An important factor affecting the solar panel’s effectiveness 
and efficacy is dust. Higher irradiation can marginally but 
not significantly mitigate the impacts of dust, and the 
reduction in peak power output can be boosted up to 30%. 
By utilizing the cleaning technique, power can be increased 
by up to 35%. The analysis indicates that the reason for the 
decrease in power is the accumulation of dust on the solar 
plates. Under actual use, microcontroller and actuator-based 
architecture ensure that PV panels operate at maximum 
efficiency under various kinds of dust circumstances. This 
proposed “A Robust IoT-Based Smart Energy Grid 
Monitoring System with Robotic Maintenance” project can 
be used in most of the solar plants. For example, in 
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apartments, schools, parks, Industry, etc. Where the 
efficiency of the solar setup can be improved. Also, errors 
can be detected easily like faulty solar or wiring. After 
rectifying these types of the error we can easily maintain the 
power generated. This is a low-cost module that will 
consume very little power. We can get the data very 
accurately and hence the production of solar energy can be 
maximized. 
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